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NEXT GENERAL MEETING

D

ave Weeshoff will present a
visual summary of the numerous technologies, historical and
current, that ornithologists, paleontologists and
climate scientists employ to study the history, behavior and destiny of wild birds throughout the world.
Examples include satellite tracking, genomic DNA
studies, ultra-high-speed photography, and sophisticated real-time data analysis.
Meet Our Presenter
Dave earned a B.S.in Experimental Psychology in 1968
from Utah State University and immediately joined IBM.
He retired in 2004 after enjoying his 35 year career with
IBM. Dave is a frequent public and classroom speaker on
environmental issues including wild bird protection, climate change, ocean plastic pollution, urban runoff and oil
spills. He has spoken on behalf of Audubon, Heal the
Bay, 5-Gyres, the Climate Reality Project, and
International Bird Rescue. He is quite familiar
with the Audubon Society’s Climate Change
Initiatives.

Tuesday, April 9, 7:30 - 9:00 PM

Westchester United Methodist Church
Fellowship Hall
8065 Emerson Ave., Westchester, L.A. 90045
Refreshments and socializing at 7:00
Informal Computer Q & A Roundtable, 6:30 to 7:20
to answer individual questions.
More info: www.lacspc.org or at

April, 2019

Dave has traveled extensively in Alaska, Arctic Canada, the Antarctic, Greenland, Iceland,
the Galapagos, Chile/ Easter Island, the Midway Atoll, New Zealand, Madagascar and various U.S. desti nations to further his knowledge and to photograph the state of our
oceans, wildlife, and their habitats.
If desired, any contribution to International
Bird Rescue would be appreciated. Its website is: https://www.bird-rescue.org/.
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FROM YOUR PRESIDENT / EDITOR
ARTICLES FROM LACS MEMBERS
Most of the articles I publish in User Friendly
come from members of other user groups.
Since there are a lot of knowledgeable and
experienced members in LACS, I have been
wondering why I never have anything written
by our own members to print?

and

Can you tell other PC and technology users
what you like or don't like? Have you learned
something from experience that you could
share? I think we could all learn from your experiences. Any computer or technology subject is fair game. Even a humorous story?
NEXTDOOR ONLINE

to all
LACS members, their
families and friends.
Errata: The dates in the headers of the roster printed in the March, 2019 issue of User
Friendly should say February. Two of the pages say March. The roster is up-to-date through
February.
The Editor of User Friendly accepts most
contributions of any suitable length from
members. Send articles to <editor (at)
lacspc.org> in an email message or as a
Word document by the 20th of the month.

Nextdoor is a social networking service for
neighborhoods. Most of our local communities
belong to a Nextdoor group. Through this network, neighbors can report missing or found
pets, recommend services and businesses,
report happenings, and post events in their
neighborhoods. Many LACS members post the
flyers for our general meetings. If you don't
already, please consider making LACS
known in this way. If you are not a member
of a Nextdoor group, visit www.nextdoor.com
to join. Enter your street address and select
Find Your Neighborhood. Complete all required
fields. This publicity may help LACS to grow.

Contest
A copy of this icon
is somewhere in this
issue. If you find it,
send an email with
your name and the page number to
<editor (at) lacspc.org>. The 1st two received
each month may win a small prize. Proofreaders and board members are not eligible. The
same person won't receive more than 2 prizes.

Bobbi Gold, Charles Mahan, Annette
Tossounian and Lee Freehling found the
March icon!
Winners may pickup their prizes at a general
meeting.
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GENERAL MEETING REPORT
March 12, 2019
By Leah Clark, LACS Editor
Google Searching with Better Results
Speaker: Hewie Poplock, Sarasota Technology
User Group, APCUG Speaker
Https://hewie.net
Hewie (at) hewie.net

T

his presentation was about how to find people
and things on your computer. Hewie Poplock,
who is in Florida, speaks to user groups all over
the country using Zoom and other means. He
maintains a website called Hewie.net, and he has
a Windows Special Interest Group for the Central
Florida Computer Society. The presentations are
on the internet and are open to all user group
members. He also has a website called Chromebooks for Seniors at cb4s.net.
Hewie shared with us many tips for searching with
Google. A search engine is a website connected to
a database that catalogs other websites. A computer search program or spider follows the links on
the webpage to regularly and automatically rebuild
this database. It searches huge databases very
quickly. There are 1.6 billion visitors per month on
Google. It processes 40,000 search queries every
second!
When you enter a letter into the Google search
box, it brings up a little menu. You can search all,
videos, images and more. Narrow down your
search by clicking on Tools. You can select results
from a specific time period.

Advanced search syntaxes will make your searches better by giving more relevant results. Start simple. If your spelling is close, Google will figure it
out. Search is not case-sensitive; you don’t need to
be concerned with capitalization or punctuation.
Start by using simple one or two-word search
terms, then refine your results by adding
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words found on the resulting pages.
To exclude a specific word from a search, put a
minus sign in front of the unwanted word. This
will omit the word following the minus sign from
the search. (Editor's note: If the minus sign appears to be a hyphen, this may not work.)
Place quotes around a search term to keep
words together in a specific order, so Google
doesn’t search on each word separately. Use
the Boolean words, and, or, or not to get more
relevant results.
Sometimes results that come at the top are ads
and are not your best results. They may even be
unsafe.
If you’re looking for answers in a particular file
type like .pdf, enter the topic followed by file
type: pdf. To find related pages type related:
followed by an URL to find similar websites.
If you order something online, put the tracking
number into the Google box to track the
package. To find the time in another zone, type
in Time: whatever place. For currency
exchange, type in the amount in one currency in
another currency. To find the weather in
another location, type weather: a place or ZIP
code. To see stock quotes, type stock: the
code for the stock.
To find your internet speed, type in speed test,
then click on the button, Run Speed Test.
Type either/or to compare two items. Also, use

vs. to find the difference between two things.
Google can track down error messages. Write
down the error message or do a screen capture
so that it can be entered accurately. Put it in
quotes, so all the words are kept in order. It can
be narrowed down by time to eliminate old, obsolete replies. The word solution or solved can
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be added to get results with an answer.
Use the asterisk * as a wild card if you can’t
remember a word. To get the definition of a
word, type define: the word. For a calculator,
type in whatever the problem is and the answer
will come up. Search in a range of numbers by
putting two periods between the numbers. For
example: to find the number one songs between
1958 and 1960, type in number one songs
1958..1960. Enter an URL: search subject to
search only within a specified site.
Type in a UPC code to track an item. This may
be a way to see if an item is still available or to
find the manual for it.
If you’re not sure exactly what word to use to
describe a situation, type a tilde ~ before a
similar word. To find who is linking to your
website, type in Link: the URL.
Enter a number = English, and Google will write
out the number in words.
Type in Reverse Image Search to identify an
image. You can upload an image to get a
description of it or to see visually similar images.
After hearing this presentation, our search time
should be more productive!
To listen to the podcast, go to
www.lacspc.org/Podcasts/SearchingWithGoogle
.mp3. If you want a copy of the excellent
PowerPoint slides Hewie used, email Stephanie
Nordlinger or Leah Clark. It is a 5MB file. 
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Six Little Word Problems and
Their Solutions
By Nancy DeMarte, 1st Vice President
Sarasota Technology User Group, FL
STUG Monitor, November 2018
www.thestug.org
ndemarte (at) verizon.net
1. You print a multi-page Word document and get
an unexpected blank page at the end of the
document. Because it has a footer, you won’t
be able to use that sheet for anything except
scrap paper.
Solution: Before you click Print, press the
Show/Hide key on the Home tab > Paragraph
group and scroll or press the Ctrl+End keys to get
to the end of the document. You will see one or
more paragraph icons on the last blank page.
Select them and press Delete.
Then save the document to avoid the blank page in
future printings.
2. You open a document and find you have to
squint to see the small type.
Solution: Go to the Zoom slider at the bottom
right of the screen and click the + sign a few times
until the document text is large enough to be comfortable for your eyes. This will not affect the text
size when printed.

3. You are just about done typing a Word document and notice that all the text in the last couple of sentences is in upper case. You had
pressed the Caps Lock key on the keyboard
accidentally.
Solution: First select the
text you want to reformat.
Then click the Change Case
tool (Aa) on the Home tab >
Font group. Click the case
pattern you want from the
list, which in this situation is
probably “Sentence case.”
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4. Sometimes you forget what version of Windows
you have on your computer. “Version” includes
the operating system (Windows 7, 8.1, or 10)
and the Windows update version number, such
as the recent update, 1809. But you’re not sure
how to find the answer.
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While you are in the Word AutoCorrect area,
check to see if you are being bothered by any
other automatic action. If so, uncheck it and click
OK.
If you change your mind, return to this screen
and re-check the boxes.

Solution: To find the version of your Windows
operating system, type in the Search box at the
bottom left of the taskbar the word winver. Then
click the winver run command to see your computer’s details.

5. When you enter an email or web address in a
document, by default Word automatically adds
a hyperlink to the address. You can identify a
hyperlink by its blue text and underline. Many
times, you don’t want the hyperlink included.
Solution: There is a way to change the setting
to stop the automatic hyperlink from being added.
Click the File tab (top left of the ribbon), then click
Options (last item on the menu). Click Proofing >
AutoCorrect options > AutoFormat and uncheck
the last item on the Replace list, “Internet and network paths with hyperlinks,” then click OK.
Just to be safe, also click “Auto Format As You
Type” and uncheck the same box there, followed
by OK.

6. You have typed a long list of items, such as
book titles, taking up several pages of a
Word document. Each title is on a separate
line. You would like to find out how many
items there are in the list, but counting them
would be tedious.
Solution: Select the entire list using Ctrl+A.
Then on the Home tab - Paragraph group, click
the numbering tool (top row, second from left) to
place a number in front of each item. Then press
Ctrl+End to jump to the end of the list, where
you can view the last number. If you wish, then
press Ctrl+Z or Undo to remove the numbering.


MY FAVORITE ANDROID APPS
By Mary Phillips, Secretary
Interactive Computer Owners Network, MO
The ICON, December 2018
www.iconusersgroup.org
Mary (at) iconusersgroup.org

B

ecause our ICON membership includes
folks who have both iPhone/iPad tablets
AND Android phones and Microsoft PCs, we try
to include diverse articles to help everyone learn
something.
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However, I don’t see many articles about
Android apps so I’ll share a little about the ones I
especially like. My smartphone is a Samsung
Galaxy S8.
 Google Assistant with Voice Recognition
I really like being able to talk to her and ask
her for information, directions or ask her to
call individuals or businesses for me.
 Do Not Disturb
My husband complained because my phone
was making notification noises during the
night and waking him up. One day I discovered Do Not Disturb. I set it to turn on at 10
PM each day and turn off at 7 AM the next
day. (Under Sounds and Vibrations)

April 2019

 Camera Zoom feature
This I like when I’m taking a picture of something at a distance and want it closer up.
 Clock
I like to take frequent naps and I set the
alarm to awaken me.
I should use the calendar for making appointments and plans, but I haven’t weaned myself
from my little daily planner yet. 

 Location
I especially like this when we’re traveling and
need directions to specific places.
 Voice Recorder
I used this when I wanted to record an audio
book for my son and his wife.
 Flashlight
I have a practice of staying up late after my
husband goes to bed and he’s turned off all
the lights except in my computer room. I turn
on the flashlight to avoid running into walls,
etc. At one of our meetings a friend demonstrated how he carries his phone in his shirt
pocket and when he’s in a darkened restaurant, he tells his assistant to turn on the
flashlight.
 Calculator – I use my calculator every time
to go to the grocery store to compare prices.
 Texting
I like texting because it’s so much faster than
email, though I do check my email if I’m expecting something.
 Portrait mode only
I keep this turned off so I can rotate to landscape mode especially when I’m watching a
YouTube “How To” video.

Setting Up for the March 12, 2019
General Meeting.

It Was a Good Meeting

April 2019

User Friendly — The Los Angeles Computer Society

FILEMENU REVIEW
By Tiny Ruisch, Member
Cajun Clickers Computer Club, LA
CCCC Computer News, February 2019
www.clickers.org
tsa70785 (at) gmail.com

C

omputers make excellent and efficient servants, but I have no wish to serve under them!

Mr. Spock in the “Ultimate Computer” was right.
Computers can be really efficient if you have the
proper programs to do the job. I’d like to tell you
about a really efficient utility program that I’ve been
using for more than ten years.
FileMenu tools let you customize the right click
menu of Windows Explorer. The program adds utilities to perform operations on files and folders and
adds customized commands that let you run external applications, copy or move to a specific folder
or delete specific file types.
With the built-in commands you can:


Run With Parameters - Runs a program with
parameters you input in a dialog box.



Command Line From Here - Opens a command line window.



Copy/Move - No need to cut and paste. You
can also use filters in file selection.



Duplicate Files - Make a copy in the same
folder.



Pack to Folder - Moves all the selected elements to a new subfolder in the current
folder.



Copy Path/Name/Content - Copies the selected item(s) to the clipboard.



Attributes - You can view and change them
without opening a properties dialog box.



Find and Replace - Lets you find or replace a
text for all the files in a selected folder.



Advanced Rename - With lots of options



Change Icon - Quickly and easily change folder options.



Advanced Delete - Lets you delete specific file
types in a folder.
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Synchronize Two Folders - Lets you synchronize two folders quickly and easily.



Shred Files - Overwrites several times, so it
is impossible to recover the file in the future.



Send to Mail Recipient - Lets you send an
e-mail with selected elements as
attachments.

These are about half of the FileMenu commands
you can select. In the configuration menu, a simple checkmark will turn off the commands you
don’t want to use. If you can’t find the FileMenu
function you need, just add a customized command to run external applications, copy/move to
a specific folder or delete specific file types.
FileMenu tools let you configure the "Send to"
submenu. You can add new items, change the
properties of the existing items or delete them.
You also can disable existing “Send to” items to
hide them from the menu.
FileMenu tools will also let you enable/disable
the commands which are added to the context
menu of the Windows Explorer by other programs. This is the only function that is not one
hundred percent reliable. When it works, it
works well, but it doesn‘t catch all of the programs that add to your right click.
FileMenu is a 7.3 MB download and runs on all
Windows platforms. Did I mention the price?
This program is freeware: It's FREE!
I’m pretty sure that Mr. Spock would say,
“Fascinating"; it's a word I use for the unexpected. In this case, I should think ‘"interesting"
would suffice.”
Download FileMenu and give it a test. I’m pretty
sure that you’ll like it.
Keep on clicking and thanks for reading. 
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LACS NOTICES
WELCOME ALL
George Wolkon, LACS Database Manager
New Members (1)
Milan Garcia
Renewals (5)
Irv Hershman
Howard Krivoy
Jack McGruder
Sheila Moncavage
Anne Uski

JOIN OUR MAIL LISTS
All you have to do to join our lists is send your
name only in the message body of an email
from the address you want LACS to use to
lacspc-subscribe (at) yahoogroups.com and
to lacslist-subscribe (at) yahoogroups.com
These lists are for members only.

FIX YOUR PC FOR FREE?
Jim McKnight has an open
offer to all LACS members to
diagnose, repair, disinfect, or
upgrade members' PC’s for free.
There are certain limitations to
Jim’s offer, so see the details by clicking the
“Fix my PC for Free?” link at www.jimopi.net.
Non-members can wisely invest in a one-year
new Regular LACS membership ($40.00), and
Jim will fix your PC problem, too. Contact Jim
for specific considerations.

HOW TO CHANGE YOUR CONTACT
INFORMATION
Go to www.lacspc.org. Click on Member Forms
in the bar under the picture. Under Membership Update, select Click Here to select either the DOC or PDF form. Fill it out and bring
it to a meeting, mail it, or email your changes to
membership (at) lacspc.org.

Lacspc is for official LACS business.
Lacslist is for any other computer-related
messages and questions.
If you have question about the lists, please contact our "Mail Guy" at mailportal (at) lacspc.org.

LACS IS ON TWITTER
On Twitter, follow us at:
https://twitter.com/LA_CompSoc or click on this
icon:

LACS IS A MEMBER
OF APCUG
www.apcug2.org
www.facebook.com/APCUG
www.twitter.com/apcug
www.youtube.com/apcugvideos

LACS HAS JOINED MEETUP
Our Meetup group is called:
"Los Angeles Computer Society and
Technology Meetup."
Please join and RSVP for our general meetings - it's free. Go to http://www.meetup.com/
Los-Angeles-Computer-Society-andTechnology-Meetup/ and click on "Join Us."
Or click on this icon to see our Meetup Page.

LACS WEBSITE
www.lacspc.org posts back copies of the color
version of User Friendly, calendar information,
and podcasts of most of our general meetings.
There is also a biannual index to past issues on
the website. Check the menu on the right side.
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LACS CALENDAR
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GENERAL MEETING PRESENTATIONS
April 9

General Meeting

Technology and Interesting Birds
of the World
May 14
Digital Asset Estate Planning Your Identity Isn’t Safe Even After
You’ve Died
Note: This schedule is subject to change.
Check email, User Friendly and our website for
updates, but mark your calendar now.

Date: Tues, April 9, 2019
Time: 7:30 P.M.
Where: Westchester United Methodist
Church, Fellowship Hall.
8065 Emerson Ave. Westchester, L.A. 90045

Listen to the podcasts of our general meetings.
Go to http://www.lacspc.org/category/audiofiles/. Click on the session you want to hear.

LACS Board Meeting

USER FRIENDLY BACK ISSUES

Date: Monday, April 29, 2019
Time: 7:00 P.M.
Where: At the home of Charlotte Semple
Contact a board member for her address.
LACS members are invited to attend.

No Special Interest Group (SIG) meeting
is scheduled for April.
New SIGs can be created if there is sufficient
interest and leadership.
Please contact the board to make your
wishes known, or to offer ideas or help.
April 1: April Fools' Day
April 19: Passover, Good Friday
April 21: Easter Sunday
April 22: Earth Day
April 24: Administrative Professionals' Day

PODCASTS

To see back issues of User Friendly, go to
http://www.lacspc.org/category/user-friendly/.
For indexes, go to
https://www.lacspc.org/category/uf-index/

GENERAL MEETING SNACK SCHEDULE
By Sylvia Q. Davis Hospitality Chair
Refreshments and socializing will be at 7:00.
The meeting starts at 7:30. Please bring
refreshments at 7:00
April 9 ............... O through S
May 14 ................ T through Z
June 11 .............. A through D
July 9 ................. E through I
August 13 .......... J through N
September 10..... O through S
Bring finger-food treats such as fruit,
veggies, nuts, cookies, cold
drinks and the like.
LACS provides hot drinks.

.

See your email for updates
and reminders.
Please pick up your leftovers
and serving pieces at the end of the meeting.
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MEMBERS HELPING MEMBERS
LACS members volunteer to help other members solve hardware and software problems by
telephone during the hours listed below. Select the topic from the list and then call a person whose
number is listed next to it. Or you may use a Helper’s e-mail address, found in your LACS Roster.
We hope that you find this free service useful. If you are experienced using a particular program or
know a topic, please volunteer to be a consultant. You don't have to be an expert. To volunteer
for this list or to make corrections, please email Leah Clark at Leahjc (at) sbcglobal.net or call her at
310-677-2792. More Quick Consultants, and more categories are always needed. You may decline
or postpone a call if it comes at an inconvenient time.
Adobe Creative Suite: PDF,
InDesign, PhotoShop, etc. - 17
Android Smartphones - 5
Apple devices - 15
Anti Malware and Backup - 5,12
Digital Imaging, Editing - 8
Digital Photography - 8
Dragon Naturally Speaking - 4
Genealogy - 5
Hardware - 12

Photoshop - 17

Linux - 11
Lotus Word Pro, Approach - 12
Mozilla Firefox - 12

QuickBooks -18
Quicken - 3, 5
Thunderbird - 12

MS Excel - 3, 15

Utilities - 5, 12

MS Word - 3, 4, 10

Visual Basic - 13

MS Outlook - 5, 15, 17

Websites - 13

MS PowerPoint - 15

Windows 7 - 16

MS Publisher - 7

Windows - 5, 12

Open Office - 16

WordPerfect - 5

Name

Preferred Phone
for Calls

3

Wilder, Joan

310-472-8445

9:00 AM

9:00 PM

4

Hershman, Irv

310-397-9453

11:00 AM

11:00 PM

5

Nordlinger, Stephanie

323-299-3244

10:00 AM

7:00 PM

7

Clark, Leah

310-677-2792

7:00 AM

5:00 PM

8

Silverstein, Elliot

310-670-1544

10:00 AM

10:00 PM

10

Beckman, Loling

310-471-7893

10:00 AM

6:00 PM

11

Hughes, Bill

424-259-1818

Any

Any

12

McKnight, Jim

310-823-7829

8:00 AM

7:00 PM

13

Ialongo, Gilbert

310-641-7906

9:00 AM

5:00 PM

15

Van Berkom, Paula

310-398-6734

9:00 AM

5:00 PM

16

Johnson, Carol

310-372-8535

10:00 AM

9:00 PM

17

Rozek, E. J.

310-823-3811

Noon

8:00 PM

18

Semple, Charlotte

310-398-5052 M-F

9:00 AM

5:00 PM

No.

From

To
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OFFICERS, DIRECTORS AND LEADERS
Title
President
Past President
Vice President
Secretary
Treasurer
Director
Director
Director
Director
Director
Director
Director
APCUG Rep.
Car Pool Coordinator
Change of Address
Corporate Counsel
CCSC Computer Lab
Greeter
Assistant Greeter
Hospitality Chair
Asst. Hospitality Chair
Membership Database
Newsletter Editor
Program Chair
Assistant Program Chair
Publicity - Press
Publicity - Online Media
Quick Consultants
Webmaster

Name
Leah Clark
Stanley Johnson
Stephanie Nordlinger
Stanley Johnson
Charlotte Semple
Paula Van Berkom
George Wolkon
Open
Open
E. J. Rozek
Howard Krivoy
Mark Presky
Leah Clark
Freda Sanders
George Wolkon
Stephanie Nordlinger
Loling Beckman
Freda Sanders
Penny McKnight
Sylvia Davis
Open
George Wolkon
Leah Clark
Stephanie Nordlinger
Open
Mark Presky
Stanley Johnson
Leah Clark
Paula Van Berkom

Term
2019
2019
2019
2019
2019
2019
2019
2019
2020
2020
2020
2020

Telephone
310-677-2792
424-216-6984
323-299-3244
424-216-6984
310-398-5052
310-398-6734
310-459-2671

310-823-3811
310-717-7465
310-398-0366
310-677-2792
323-230-3278
310-459-2671
323-299-3244
310-471-7893
323-230-3278
310-823-7829
213-924-4927
323-230-3278
310-459-2671
310-677-2792
323-299-3244
310-398-0366
424-216-6984
310-677-2792
310-398-6734

Website

www.lacspc.org

Newsletter Editor

editor (at) lacspc.org

Voice Mail

1-310-398-0366

Webmaster

sitemaster (at) lacspc.org

E-mail

ContactUs (at) lacspc.org

Change of Address membership (at) lacspc.org

The ContactUs (at) lacspc.org address goes to our president and vice president. If the message
is for another officer or member, they will forward it to the correct person. To contact other
officers, directors, leaders or members directly, members may use our roster for phone numbers
and e-mail addresses.
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PRINTER PROBLEMS
By David Kretchmar
Computer Hardware Technician
Sun City Summerlin Computer Club, NV
The Gigabyte Gazette, January 2019
www.scscc.club/
Tomburt89134 (at) cox.net

P

rinters are the most problematic piece of computer
equipment, next to the computers themselves. Just like computers, you can’t live with them,
and you can’t live without them. Even if you’ve
decided you can live without a full computer and
have moved to a tablet or maybe just your
smartphone; there are still going to be occasions
when you want to have a “hard copy” (printed
copy) of a document. Also, with the multifunctionality of most printers today, most of us
are used to the convenience of having a photocopier, scanner, and maybe even a FAX machine in our homes.
It’s easy to understand
why printers are such a
pain; there are so many
moving parts and opportunities for something to go wrong. Fortunately, you can address many printer
problems using the techniques I’m going to describe. If none of the following work, it is probably time to bite the bullet and invest in a new
printer. If something mechanical is shot in a
printer, the fix is often prohibitively expensive
(just buying some new printer heads can cost
over $100).
The USB connection
Unless you’re using a printer wirelessly, you
need a working USB connection between your
computer and your printer. Sometimes a wireless connection is necessary, such as when
printing from a cell phone, tablet, or from a computer not proximate to the printer. But if you are
printing from a computer adjacent to the printer,
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a wired USB connection is always more reliable
and highly recommended. Most of us know how to
connect the standard USB
male connector to our computer, but there is more
confusion with the other end
of that USB cable that attaches into (usually) the
back of the printer. See the
picture to the right.
Unfortunately, the printer end of the USB cable
also fits into the similar looking telephone line connection on the printer. Usually, there is a pair of
these female telephone line connectors on printers that include FAX capability; at least one will
often be covered with a plastic cap.
One way to tell if you are using the USB connection on the printer is to listen for the USB
“handshake” tone from the computer. If both your
printer and computer are on, you should hear a
couple of notes when you plug in or remove a
USB device. If not, most likely you have missed
that USB connection on the printer. Be especially
aware of this possibility if you are setting up a
printer new to your system, or if for some reason
the cable has become disconnected from your
printer. It is rare for the USB cable to go bad, but I
have seen this on occasion.
Drivers can drive you crazy
The printer and the computer must be able to
communicate with each other, and this is accomplished with specialized
software known as drivers. Windows 10 has
printing drivers for most
of the newer printers available today, but I strongly
suggest installing the drivers furnished by the
computer’s manufacturer. This is especially true if
you want to do more than print, i.e., if you're going
to scan a document into a file.
A new printer will usually come with a CD that can
be used to load the drivers appropriate for your
operating system. If you have a tablet or other device that does not include an optical drive you can
go the printer manufacturer’s website, i.e.,
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hp.com/support, and download and install the appropriate drivers. If you have a choice between
downloading the basic or full-featured software
package, I suggest downloading the full-featured
package then doing a custom install, installing only
the software you will be using. For whatever reason, the full-featured software package sometimes
works when the basic package does not.
Manufacturers will often keep their website drivers
more up to date, fixing bugs that have appeared
after the printer has been on the market for a while.
So, if you are having issues with your printer, it’s a
good idea to download drivers from their website.
When you do the custom install of your printer software, I suggest you deselect features such as the
customer participation programs and supply ordering programs. I would also pass on the free optical
character recognition (OCR) program, unless this
is something you will use. OCR programs can be a
real resource hog.
After the driver installation and a reboot see if any
new programs are loading automatically by seeing
if any new icons are appearing on the right side of
your taskbar. If so, you might want to open
MSCONFIG and stop these programs from loading
on startup. If you get a popup asking if you want
low ink notifications immediately or “only when
printing,” select “only when printing,” so this program will not constantly be running.
If you are buying a printer to use with a wireless
device such as a Kindle Fire, Smartphone or iPad,
do some research and make sure you are getting a
printer that is supported by your device.
As you might expect with the popularity of the iPad,
many printers will support the iPad with a free
download from Apple. I’ve noticed
that especially newer
Hewlett Packard wireless printers are made
to be compatible with
the iPad. 
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COMPUTER FLU SEASON ON
WINDOWS
By Jim Cerny, Forum Leader
Sarasota Technology Users Group, FL
The STUG Monitor, January 201
www.thestug.org
jimcerny123 (at) gmail.com

D

id you get your flu shot this year? It’s always good to protect your health from
those nasty germs and viruses – and the same
is true with your Windows computer. In this short
overview, we will cover some essential basics of
computer protection.
There are many FREE anti-virus protection programs (apps) out there, and almost all of them
offer an “upgraded” version for a monthly or annual fee. I really have no experience with what
the upgrades ($) versions offer compared to
their free version, but I have used the free Windows Defender for quite a few years now and
so far, so good. Windows Defender comes with
Windows, and it may already be active on your
computer. Just left-click on the little Windows
icon in the lower left corner of your screen, and
you will see an alphabetical list of all your apps.
Left-click on Windows Defender Security Center
and you will see if this program is running on
your computer.
You do need an active “running all the time” virus protection program on your Windows computer to protect you from the nasties. If you use
another virus protection app, remember that
only ONE virus protection program should be
active or running; do NOT try to run two at the
same time – they will interfere with each other
and bring your system back to the stone age of
slowness. I think it is wise to delete all other
virus protection apps from your computer except
the one you are actively using. On my computer,
if I delete an active virus protection program,
Windows Defender steps right in to protect me
right away. That’s very nice of it. Whatever virus
protection app you are running, check the options for “automatic updates” and turn it “on”.
That way it will update itself without you having
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to do anything.
Like they say on TV – “But wait, there’s more...”
and there is. Besides active virus protection, you
also should use some free software that will
SCAN your system for problems. In my case, I
use CCleaner (note the two-letter C’s) and Glary
Utilities. There are probably at least a dozen
more you can pick. These apps are not “always
active” type of virus protection – you have to run
them. I usually run both of them every day; it
only takes a minute.
Of course, ALL of these apps have multiple options, tools, and things you can do with them.
For example, Windows Defender has an option
to scan your computer for problems, too – a
“quick,” “full,” or “custom” scan. Whatever app
you choose, please take some time to learn
about it by searching YouTube – “How to use
Windows Defender” for example. You do not
have to learn all the options – there are way too
many, anyway – but only the basics.
As another example, Glary Utilities can also tell
you what software upgrades you need and install them for you – a very nice option. Please
ask your friends and relatives, “What do you use
to protect your computer?” And searching the
internet for the “most popular” apps is always a
good idea too. I am sure you are aware of how
great it is to use Google or YouTube to find very
helpful videos on how to use whatever apps you
pick. If you run ANY app, it is always a good
idea to watch a ten-minute video about it. You
will learn not only how to use it for the “basics,”
but also will learn some of the popular options
that may also be helpful to you. Most of the options or choices offered are way over my head,
so I just stick with the basics.
Unfortunately, nothing is guaranteed. You could
pay good money for protection and still get a
virus. But it is always better to have something
than nothing. And if that
something costs nothing,

well, that’s not a bad deal.
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IS CHANGING MY PASSWORD
ENOUGH?
Ask Leo by Leo Notenboom

I

regularly hear from people who've had their
email or other online account compromised, are
able to recover access to it, and change their
password, only to have the account stolen again
almost immediately.
The problem is simple, but the solution is a bit of
work.
First, you have to realize that while someone else
has access to your account, they have access
to everything related to that account.
As a result, changing your password just isn't
enough. You need to do more.

Recovery Information
You authenticate with most online systems by
providing a user name and a password. Your user
name might well be publicly visible, but your password should be known only to you.
Most systems also provide a mechanism whereby
you can recover or reset your password should
you forget it. They use a variety of means, but they
all boil down to the same thing: they use one or
more additional pieces of information — often referred to as recovery information –– to validate
that you are who you say you are, and thus entitled to regain access to the account.
It's that recovery information that presents the
greatest risk once your account has been
compromised.
Let's look at some examples of what I mean, why
it's a risk, and what you should do about each, in
addition to changing your password.

Email Addresses
Many, if not most, online accounts require your
email address. In the
case of an email account, like Outlook.com, Gmail, or
the like, there's also
often an "alternate"

April 2019

User Friendly — The Los Angeles Computer Society

email address.
Systems often provide the ability to send a password reset message to the email address of record, or the alternate email address, should you
lose your password. Since only you could have
set it up, by definition, that email address should
be yours. Your ability to receive a message at that
address confirms you are the rightful account
holder.
Once your account has been compromised, a
smart hacker will immediately change the email
address or the alternate email address to one he
or she has access to. That way, if you request a
password reset, they'll get it, not you. Similarly, if
you change the password, all the hacker has to do
is request a password reset, and she'll regain access to the account.
What you should do: once you've regained access
to your account, immediately verify that all email
addresses associated with that account are yours.
If they aren't, change them right away.

Secret Questions
It's falling out of favor these days, but as a second
layer of security, many systems have you set up
answers to security questions. The answers you
choose verify your identity should you lose your
password, and so are questions only you should
know, such as your mother's maiden name, the
name of your first pet, or your favorite teacher. If
you forget your password, the system asks you
one or more of these questions. If your answer
matches what you set up originally, then you must
be who you say you are, and you regain account
access.
One of the problems with the technique is that often, the answers aren't secret at all. Even a little
browsing on your social media sites can tell potential hackers a great deal about you, including
many of the answers to these so-called secret
questions.
Of course, once a hacker has access to your account, he can change all the answers to his own.
That way, should you regain access to the account and change the password, she can just invoke the password recovery mechanism and regain access herself.
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What you should do: once you've regained access to a hacked account, change all your secret answers immediately. Even if they've been
untouched, the attacker could simply have written them down. Change them to something new
— ideally, answers that are completely unrelated to the questions, but that you'll remember.

Mobile Numbers
Many service providers are now replacing secret
questions with the use of mobile or phone numbers instead. The concept is that when account
recovery is needed, they can text or voice call
that number with a code. You provide that code,
which proves you have the phone. Since you set
up that phone number, you must be the authorized account holder.
By now, you probably realize that once a hacker
has access to your account, they can and do
change that number to be their own, too. Any
mobile-based account-recovery attempts are
now redirected to the hacker.
What you should do: as soon as you get back
into your hacked account, confirm that the
phone numbers associated with it are still your
own.

Billing Information
It's rare, but some systems use billing information, such as a credit card number already on
file or your billing address, in account recoveryand-validation attempts. If you have this kind of
information on file, 1) a hacker may be able to
start using it, potentially racking up charges that
you may or may not be liable for, and 2) a hacker can change it, so if it's used for account recovery purposes, it's the hacker who regains
access, not you.
What you should do: change or remove this information as soon as you get your account
back, and check with your credit card provider
immediately for any improper charges.

The Bottom Line
By now, you should see a distinct pattern: any
and all information that can be used to recover
your account should be validated, removed, or
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changed the instant you get your account back.
That includes personal information, PINs, secret
questions and answers, alternate email addresses, and more: anything the system you're
dealing with might use for account validation
and recovery.
If you don't, and the individual who hacked your
account has even half a clue (and many do
these days,) it's very possible you could recover
your account only to find it hacked again within
hours or minutes.
You should also consider increasing the security
of your account by adding two-factor authentication to prevent future hacks, as well as setting
up any single-use or pre-defined recovery
codes for those systems that support it.
This is an update to an article originally posted
November 6, 2009
Originally published as Is Changing My Password Enough? on Ask Leo!
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Listed below are five additions that come with this
update and that I found useful for the average
user.
1. A new Snip & Sketch app (that will eventually
replace the Snipping Tool) was added that supports the use of a stylus and the option to start
it with the shortcut Win key + Shift + S.

2. Change System font size
Using a new slider, it is easy to adjust the font
size for the Start menu, titles, message boxes,
and tool tips for all apps. Select Settings and
enter Make text bigger in the search box. To
increase the size of text on your screen, adjust
the slider under Make text bigger. To make
everything larger, including images and apps,
choose an option from the dropdown menu under Make everything bigger.

Have a question? Use
Ask Leo! for Subscribers to drop me a line. 
Any works by Leo Notenboom of Ask Leo! that
are printed in User Friendly are licensed under a
Creative Commons Attribution- NonCommercial NoDerivatives 4.0 International License. User
Groups have permission to use them.

THE WINTER 2019 WINDOWS 10
UPDATE
By Rosita Herrick, Forum Moderator
Sarasota Technology Users Group, FL
The STUG Monitor, January 2019
www.thestug.org
hrosita (at) aol.c

B

y now, some of you have already updated
to the current version of Windows 10 and, if
not, you should soon receive the update on your
computer. Once your PC is updated, the Windows version will show as Version 1809 (OS
Build 17763.134)

3. Cortana
The display that pops up when the user clicks
on the Cortana search box has changed. As
you can see below, you can click on any of the
blue boxes to limit where Cortana looks for the
search argument. Also, below the boxes the
links displayed are the items the user had
worked on previously. As you can see, the first
item is the title of the Word document that I am
preparing for the Monitor, so I can pick it up
later if I have to stop at any time.
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INTERESTING SITES TO VISIT
ON THE INTERNET

4. There is now a new keyboard short cut to start
a second screen of an active app. The
shortcut is Ctrl + N. For example, in the picture
below I have an open File Explorer screen.
Pressing the shortcut Ctrl + N gave me a second screen. This is very handy when you want
to copy or move either a file or folder from one
place to the other. The pages can be separated by clicking on the blue bar of the active
screen and dragging the page.

By Nancy Preffitt, Member
Interactive Computer Owners Network, MO
The ICON Newsletter, January 2019
www.iconusersgroup.org
mphillip1.mary (at) gmail.com

5. The new Cloud-powered clipboard introduces
a new interface (which you can invoke using
the Windows key + V shortcut) to view your
history, paste previous content, and pin items that you
may need to paste on a daily basis.

The Federal efforts have been a flop! Download
it from the Play Store and see what you think.
https://play.google.com/store/apps/details?
id=com.truecaller

6. Search experience
Searching for an app or document, the right
pane will now show common actions, including
options to run an app as an administrator, file
information, such as path and the last time the
document was modified, and more.

Editor's note: The screenshots in this article may
be difficult to read in print. But they do give an idea
of what to look for. Follow the instructions to see
them clearly on your screen. 

SPAM BLOCKER THAT WORKS?
Spam has become a real nuisance for all of us
who have phones. It’s worse on our house
phone than the cell, and for those of you who
use cells exclusively, it must be the same nightmare. I just ran across Truecell which can allegedly block calls, show you spam before you answer, and even chat. It's free and lets you find
out who's behind that unknown number. Just
copy and paste the number to the search bar
embedded in the app. There’s a lot of potential
good with the app, and maybe it really does work
well.

WHAT EXACTLY HAPPENS WHEN I TURN
ON MY COMPUTER?
We all turn on and off our computers without
thinking much about it. Hit the button, and the
screen lights up, and the programs become viable, and we do whatever. If you’d like to understand the process, read this How-To Geek article
that explains it very nicely. https://
www.howtogeek.com/398493/what-exactlyhappens-when-you-turn-on-your-computer/
P. S. – I just learned something! At the top of
one of these articles (I was on Firefox) I noticed
a little box that said “Toggle Reader View f-9”.
Hmm … never noticed that before. I poked the
F9 button and, magically, the page turned into
an ad-free, nicely arranged page that was much
easier to read than dodging ads and videos and
such! Did you know about that? 
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RIDE SHARING

If you need a ride to a General Meeting, or if
you are able to give a ride, please contact
Freda Sanders at 323-230-3278.
TECHBOOMERS
teaches how to use various websites and
internet-based applications.


https://TechBoomers.com



https://www.youtube.com/watch?v=O2bwYIYu1I

SPECIAL OFFERS
Go to the APCUG website
https://apcug2.org/discounts-special-offers-foruser-groups/ for discounts and special offers for
User Groups Members. Avast Anti-virus and
Acronis True Image, and several book, media
and training sites offer discounts including the
two mentioned below.

April 2019

LAUGHING OUT LOUD
Mom had just returned from shopping and was
surveying the ghastly scene in the den. The
family computer had been totally smashed into
a dozen pieces.
"What happened to the PC?" she asked of her
14 year old son.
"That was dad's doing," he replied. "As usual
he couldn't get it to do what he wanted. I told
him to reboot it. That's exactly what he did."
A police officer said to a motorist, "What were
you doing?
Your car was zigzagging like crazy!"
"I'm learning to drive."
"Without an instructor in the car?"
"Oh, yes. It's an online course."

Members can save at the
Pearson Technology websites:
InformIT, Cisco Press, Pearson IT Certification,
Que Publishing, Adobe Press, and
Peachpit Press.
Informit.com/user_groups/index.aspx
Code for print books: ITCOMMUNITY
Code for eBooks: DIGITALCOMMUNITY
See the latest books on digital imaging and
photography, gaming, animation, film and video,
post-production, audio, music technology,
broadcast and theatre from Routledge | Focal
Press today! They offer discounts to User
Groups members.
NOTICE
The columns, reviews and other expressions of opinion in
User Friendly are the opinions of the writers and not necessarily those of the Los Angeles Computer Society.
LACS became a California non-profit corporation on July
17, 1991. Its predecessor was the UCLA PC Users
Group.

FINANCIAL REPORT
A LACS member who wishes to see or has questions
about our financial reports may contact our treasurer.

COPYRIGHT © 2019
by the Los Angeles Computer Society, an all-volunteer,
tax-exempt [IRC Section 501(c)(3)] nonprofit California
corporation. All rights reserved. User Friendly is published
monthly. Subscriptions are included in membership dues.
Reproduction of any material here by any means is expressly prohibited without written permission, except that
other nonprofit User Groups may reprint LACS articles in
substantially unaltered form if credit is given to the author
and this publication and an e-mail is sent to
<editor (at) lacspc.org> reporting the reprint information
(user group and the name and date of the publication).
Product and company names are the trademarks of their
respective owners.
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MEMBERSHIP INFORMATION
Annual membership Dues:
Regular New and Renewal,
Printed Newsletter
$ 40
Electronic Newsletter
30
Family-Associate
12
Students
18
Contributor
50
Supporter
75
Benefactor
100
A subscription to User Friendly is
included with membership.
Associate members are those
who live in the same household
or work at the same address as a
regular member; they do not
receive their own subscriptions to
User Friendly, but may read it on
the LACS website. Students
must prove full-time status.

In addition to monthly general
meetings, members enjoy
these special benefits:
— Monthly Newsletter
User Friendly. We publish your
article submissions or free
classified ads to buy or sell your
computer items.
— Get FREE help by phone
from knowledgeable members
who are Quick Consultants
listed in User Friendly.
— Get help by email by
using our LACSLIST Yahoo
Group Mail List. Send your
questions by e-mail to
lacslist (at) yahoogroups.com
— Receive important news
and announcements via User
Friendly and LACS’s Yahoo
Group e-mail lists.

— Occasional product discounts,
special offers, etc.
— Special Interest Groups
(SIGs) on various topics may be
created to help you to learn, to
share interests, and to solve your
computer problems.
— Information on training,
swap meets and trade shows.
— Occasional Free software and
computer books, if you review
them for User Friendly.
— Rewards for recruiting;
LACS will extend your membership
for three months for each new regular member you recruit.
— Annual Holiday Party
— Field trips
— Social Interacting with others who have like interests in computers and technology.



New or Renewal Membership Application
Please bring your dues and this form to a meeting or mail them to:
Los Angeles Computer Society, 11664 NATIONAL BLVD. #343, LOS ANGELES CA 90064-3802
[ ] New
[ ] Renewal
Please PRINT Clearly
[ ] With printed newsletter [ ] $40.00
[ ] Associate $12.00

[ ] Student - $18.00

[ ] With electronic newsletter, not printed [ ] $30.00
[ ] Contributor $50.00
[ ] Supporter $75.00
[ ] Benefactor $100.00
[ ] Other $_______
____________________________________________________________________________________
Name: First
Last
____________________________________________________________________________________
Name of Associate: First
Last
____________________________________________________________________________________
Address:
____________________________________________________________________________________
City, State, Zip + 4
____________________________________________________________________________________
Email:
Email of Associate:
____________________________________________________________________________________
Preferred Phone:
Publish Contact Info in Roster [ ] Yes [ ] No
______________________________________________________________________________________________
Did a member of LACS invite you to join? If so, who? If not, how did you hear about LACS?
Revised: Nov. 2018 ljc

Editor…..…………........... Leah Clark
Indexer ……….…............. Leah Clark
Podcast Transcriber ... Irv Hershman
Photographer……...................Vacant
Proofreaders …...... Lance Hegamin,
Jim McKnight, Stephanie Nordlinger,
and Charlotte Semple

FREE!
Earn 3 months of free
membership for every new regular
member you bring in.

is published by the Los Angeles Computer Society.
11664 NATIONAL BLVD, #343 LOS ANGELES CA 90064-3802

DIRECTIONS TO
GENERAL MEETING
Westchester United Methodist
Church Fellowship Hall
8065 Emerson Ave.
Los Angeles CA 90045
From the North:
Take Sepulveda Blvd. SOUTH
to W. 80th St. Turn WEST/right.
Go about one mile to Emerson
Ave. Turn SOUTH/left. Go one
long block to W. 80th Place. It
is on the Northwest corner of
Emerson and W. 80th Place.
From the South, East or West:
Take Manchester Ave. to
Emerson Ave. Turn NORTH. Go
about eight blocks to W. 80th
Place. Fellowship Hall is on the
Northwest corner of Emerson
and W. 80th Place. There is
street parking and a small
parking lot West of the church.

